Creating accessible Excel spreadsheets

By thoughtful application of some simple techniques and strategies, your Excel spreadsheets can be made very accessible. The latest versions of access software such as JAWS are optimised for use with Microsoft Office programs including Excel.

Appropriate formatting and design considerations will aid effective navigation and use by all users and not just those who are blind or partially sighted.

1. Design

Design basics
A well designed spreadsheet is of benefit to everyone and not just blind and partially sighted users.

Spreadsheets can provide perfectly accessible information providing that appropriate formatting is used to create the tables of data. Most screen reader software and screen magnification software include specific functions for reading Excel spreadsheets.

No special formatting is needed to create a table in Excel. The entire worksheet is a grid which you can populate with text and data.

However, this flexibility can create accessibility issues. For example, text such as titles or notes can be inserted into cells that are not part of a table. Unfortunately text which is not part of a table can cause access and navigation problems for blind and partially sighted users.

Top ten accessibility pointers
1. Break down complex data sets into logical tables ideally with their own worksheets. New tables should be created on separate worksheets to aid navigation and understanding.
2. Reserve the first worksheet for a contents or index page.
3. Use Clear Print guidelines for text and data.
4. Insert all text and data within a logical path that a keyboard only user would take. As a general rule keyboard users will navigate down from cell A1 until the table is reached.

5. Empty cells within a table should be marked as such with a minus sign, a zero or N/A for not applicable as appropriate.

6. Adjust cell height and width to ensure all text that you want to appear is visible in your spreadsheet.

7. Add text descriptions and Alt text to charts and graphics.

8. Avoid using visual devices such as colour, shading, patterns and borders to divide up data regions.

9. Avoid merging data or header cells. Merged cells cause navigation problems and will not be read correctly if they contain row or column headers.

10. Always save your spreadsheet with the focus on cell A1 unless you want to draw attention to a specific cell.

**Hint**

Avoid setting text in a vertical or diagonal direction and adding spaces between letters in a word for visual effect. Screen reader and magnification users will find such text difficult or impossible to access.

**Keyboard shortcuts**

Tab = move one cell to the right
Shift Tab = move one cell to the left
Arrow keys = move in any direction
Ctrl Arrow key = move to edge of table in direction of arrow

**Clear Print guidelines**

Following Clear Print guidelines for spreadsheets will help ensure that your information is accessible to as wide an audience as possible.

Good design will also ensure that information can be accessed more efficiently by everyone and not just access technology users.

**How to use Clear Print**

- Table layout should be predictable and easy to navigate.
- Comment and signpost cells used where appropriate.
- Each new table on a separate worksheet.
- Row and column headings effectively formatted.
- Headers and footers not used to convey important information.
- Cells formatted so that all text is visible.
- Font colour set to automatic.
- Information provided through cell patterning and conditional formatting also provided via text.
- Floating elements such as graphics and text boxes not used.
- Graphics, where necessary, on a separate worksheet.
- Concise text descriptions of graphics and images provided.
- Overall spreadsheet and individual worksheets have meaningful names.
- Unused worksheets deleted.
- Users are alerted to filters and frozen panes.
- Cell focus is left in a logical place when saving and closing the spreadsheet.

Basic settings for Clear Print can be set up as defaults for use with any new spreadsheet you create.

**Clear Print settings**

1. Select Tools, Options and General to set the following options [Alt T, O, G].
2. Select Sheets in new workbook and change this to 1 [Alt S].
3. Select Standard font and change this to Arial [Alt A].
4. Select Size and change this to 14 [Alt E].
5. Select Ok or press Enter to close the tab.
6. To set colour to automatic select Format, Cells, Font [Alt O, E, F].
7. Select Colour and change this to Automatic [Alt C].
8. Click Ok to close the tab [Enter, Tab, Enter].

**Hint**

Setting the default worksheets to one means you only add extra worksheets if you actually need them. To add a new worksheet select Insert, Worksheet [Shift F11].
Keyboard shortcuts
Shift F11 = insert new worksheet
Ctrl + Page Down = move to next worksheet
Ctrl + Page Up = move to previous worksheet

Large print
Documents in large print may be requested by people who have some useful sight but prefer larger than standard 14 point Clear Print.

Large print should always follow the Clear Print guidelines as regards text and layout.

Large print type size
Whereas Clear Print is 14 point type size, large print starts at 16 point. Always ask to identify the preferred reading size but if you are unable to find out from your recipient or colleague their required type size, you might offer 18 point.

Remember that access technology can enlarge the text for a user, so no alternatives may be necessary.

Reasonable limits to the size of print
Requests for type sizes above 28 point should be carefully considered for effectiveness. Very large type sizes can be counter-productive because they cause publications to become bulky and difficult to navigate. Alternative formats can be offered to avoid running into these problems.

How to make your spreadsheet large print
1. Highlight your entire worksheet [Ctrl A].
2. Change the Font Size to the new value [Ctrl Shift P].
3. To resize cells to fit the enlarged print select Format, Column, AutoFit Selection [Alt O, C, A].

Important quality checks
- Spreadsheets enlarged in this way should always be carefully proof checked.
- Particularly look for numbers which will appear as a line of hashes if the cell is too small.
• Large print should never be created by enlarging a standard print document using a photocopier.

• Pictures and images should be checked to ensure they work at a larger scale.

• To avoid possible problems always use AutoFit Selection to change the size of cells.

**Colour**

By leaving the colour selection set to automatic Excel will always try to maintain a strong contrast between the foreground and the background. This has the additional advantage that partially sighted users are free to modify the colour selection to best suit themselves. If colour alone is used to highlight important aspects of a spreadsheet then this can cause problems for blind and partially sighted users and those with colour vision deficiencies, for example. Where colour has to be used you can apply additional techniques to help ensure the meaning is conveyed to as many users as possible.

• Try to provide additional cues in the text to draw attention to the meaning of the colour. For example, text marked in red could also have a comment which would be read out by a screen reader.

• Dividing areas of a large table up by colour alone is not really accessible. A more accessible design solution would be to divide the large table up over several worksheets.

• With a bit of thought it is possible to design your spreadsheet so that screen reader users can filter information using the same criteria that determines the colour.

**A note about conditional formatting**

Conditional formatting is where the colour of a cell changes according to a pre-set condition. Unfortunately, at the present time there is no acceptable method of making conditional formatting accessible.

**Accessible forms in Excel**

The more accessible a form is the more likely you are to get a good response rate. Simple techniques can be used to design forms that are accessible to as wide an audience as possible.

Even where forms are to be posted out, following Clear Print guidelines and the advice given here will help to ensure that print versions are as accessible as possible.
Designing for accessibility from the start will help to ensure that alternative formats such as large print, braille and electronic versions can be more easily created.

**Top 10 tips for accessible forms:**

1. The title should clearly state that the document is a form.

2. Give a clear description of the structure of the form in Worksheet 1. For example, you may want to include the number of questions or sections, an estimate of the time required to fill in the form and any special instructions which may apply.

3. Make all instructions for completing the form clear and unambiguous.

4. Ensure that the structure is meaningful when navigated using the keyboard. Two column table grids are a recommended technique for accessibility. For example, questions in column A and answers in column B.

5. Information which needs to be repeated on separate worksheets can be gathered once on the first page and then automatically inserted.

6. Questions and response fields should follow a logical format for keyboard users.

7. Make sure questions are worded to be compatible with screen readers. For example, Type your name here:

8. Include contact details for getting help if required. For example, a recipient may want to request an alternative format.

9. Ensure that instructions for returning the form are comprehensive and accessible.

10. Add text descriptions or comments to questions where specific types of responses are required. For example, if the answer needs to be chosen from a given list of items.

**Hints**

- Run a small pilot of your form or survey first. Apart from checking for accessibility you can also ensure that the information returned is what you actually want.

- Avoid questions which use visual references such as Tick the appropriate box or Delete as appropriate.

- Don't use lines of full stops, underscores or other characters to indicate where responses should go.
• Questions which rely purely on visual elements or layout to make sense will not be accessible.

**Simple table layout**
Excel lends itself to using table layouts for producing accessible forms. Forms with simple uniform table layouts can be easily navigated from the keyboard.

**How to create a 2-column form**
A recommended technique is to use a two column table with questions typed into column 1 and answers in column 2.

1. Create a two column table grid. Please refer to the section on formatting tables and headers if you need a reminder.
2. Label the top cells of the table. The first column could be labelled Question and the second column Answer, for example.
3. Appropriate instructions should be given above the table or on a separate header page. Comments can be added to question cells if required for clarity. You should include the following information:
   - The form uses table layout
   - Column one contains the questions
   - Column two is where the answers are typed
   - Who to contact for help with filling in the form
   - Where to send the completed form
4. It is also good practice to include the number of questions so that screen reader users will know when they have reached the end.

**Hints**
• Run a small pilot of your form or survey first. Apart from checking for accessibility you can also ensure that the information returned is what you actually want.
• Avoid questions which use visual references such as Tick the appropriate box or Delete as appropriate.
• Don't use lines of full stops, underscores or other characters to indicate where responses should go.
• Questions which rely purely on visual elements or layout to make sense will not be accessible.
Always put important information at the start of the form or on a separate information or header page.

The header page in a complex form can hyperlink to appropriate worksheets.

Use the header page to collect information which needs to be repeated throughout the form such as Employee name, Employee number etc.

Any information to be added to the form after completion by the recipient should be included at the end of the form.

Advanced functions

Following the guidelines given in these pages should ensure that you are producing spreadsheets which are accessible for all your potential users. Excel is a vast subject and there are simply too many functions and features to list the accessibility implications of them all.

As a general rule accessibility problems can occur where advanced functions are used to lock or restrict spreadsheet access in some way. Hidden information is likely to remain so if an access technology user does not know it is there.

In particular, frozen panes and filters will not necessarily be obvious to access technology users. Where such features are deemed to be essential it is important to document their use and where possible how to switch them off.

The page on Saving and sharing will help you to ensure that when a user opens your spreadsheet they experience it exactly as you intended. For example, did you know that Excel always saves the cursor focus exactly where you left it?

2. Structure

Structure basics

The structure of your spreadsheet can go a long way towards ensuring that it is as accessible as possible to your users. If a little care is taken at the beginning your spreadsheets can be a very effective and accessible means of conveying information and data.

Leading accessibility software such as JAWS can work very well with Excel spreadsheets providing a few simple guidelines are followed.
Top tips for structure

- Rather than have multiple data tables in one worksheet it is much better to create a worksheet for each table. The first worksheet can act as an index with hyperlinks to enable users to quickly jump to desired locations.
- Give your data tables row and column headers to aid navigation.
- Data tables should be positioned against the top and left hand edges as keyboard users will generally navigate from Cell A1 in the top left corner unless signposted otherwise.
- Visual effects such as merged cells should be avoided as this can cause disruption to the structure making accessibility more difficult. In fact, Excel naturally expands text over adjacent cells if necessary without affecting the underlying structure of the spreadsheet.
- Data tables should allow the cursor to navigate logically around the rows and columns. This can be easily checked using the arrow keys.
- Try to avoid large gaps between data areas and purely visual effects together with blank rows and columns as these can all cause confusion to keyboard users.

Divide and conquer

Complex data sets can generally be broken down into smaller tables to aid navigation and accessibility. Ideally, these tables can each have their own worksheet which can be navigated to and accessed from a contents list or index page.

Where multiple tables do need to be placed on a single worksheet there are a few points to bear in mind:

Single worksheet

- Tables should border the left hand edge of the worksheet.
- Tables should ideally be separated by a single blank line. Large gaps between tables could well be missed by screen reader users.
- Give each table a title reference.
- Similarly, row or column gaps in the tables themselves may be perceived by keyboard users as the edge of the data area rather than a divider.
Multiple worksheets

The most accessible spreadsheets tend to be those which make full use of worksheets to display individual tables, charts and graphs. Combine this with an index or contents page which signposts the user to the various parts of the spreadsheet and you will help to make your data easier to understand for everyone and not just blind or partially sighted readers.

Hyperlinks can be used within Excel spreadsheets to quickly navigate from the index to the different worksheets, for example.

Don’t repeat yourself!

Sometimes information obtained from the user needs to be repeated throughout a complex spreadsheet. This information may include name, date of birth and employee number, for example. In these circumstances such information can be gathered just once on a purpose designed worksheet and then applied automatically where required throughout the spreadsheet.

Information and index pages

Providing information about the structure and layout of your spreadsheet is useful for all users but especially blind and partially sighted people who cannot easily get an overview.

- A good starting point is to reserve the first worksheet in your spreadsheet for information and navigation.
- You can provide a text description of how the worksheets are set out and organised.
- It is helpful to provide an index or a list of contents which can be hyperlinked to the appropriate worksheets.

Worksheet descriptions

As well as providing information on the first page of your spreadsheet you can provide further navigation within the associated worksheets.

- Text within cells can be used to explain the layout of a worksheet or to point screen reader users to specific locations.
- As well as using straightforward text in a cell, screen reader software can automatically detect and announce the presence of comments. This is explained in more detail in the ‘adding comments’ section.
Hints

- Add a hyperlinked contents list to your index page to make navigation across the worksheets even more accessible.
- Descriptions can point users to locations which may not be immediately obvious.
  - For example: Table 1 labelled 'Cost breakdown' starts at cell A4 on this worksheet, notes are included at cell A50 and table 2 listing the various options is on the worksheet labelled 'Allowances'.

Hyperlinks

Good practice with spreadsheets containing multiple worksheets is to create a hyperlinked contents list or index page on Worksheet 1.

A text description of how the spreadsheet is laid out should also be provided on the index page. Providing an overview of the layout of your spreadsheet is good practice for all users but especially blind and partially sighted people who cannot easily do this visually.

Make effective use of hyperlinks to enable users to quickly move around your spreadsheet especially if it contains multiple worksheets.

How to create a hyperlink

1. Highlight the cell containing the text to be hyperlinked.
2. From the Insert menu select Hyperlink [Alt I, I].
3. Select Place in this document [Alt A].
4. Type the cell reference for the hyperlink [Alt A]. Note that the default reference is cell A1 which is generally a logical starting point for screen reader users.
5. Select the worksheet containing the cell you are linking to [Alt C].
6. Click Ok or press Enter to create the hyperlink.

A note about buttons

In Excel the Forms toolbar allows a variety of buttons to be inserted into your spreadsheet to trigger user defined functions. Unfortunately, screen reader software is not generally able to recognise these buttons or enable users to interact with them using the keyboard in Excel.

In some cases it may be possible to format a standard cell to look like a button, with a hyperlink that triggers the required function. Cells can be
modified using some mild visual formatting, such as adding a cell border or subtle colour backfill, to create the appearance of a button. However, it is important to find a design that will not be detrimental to screen magnification and high contrast display users.

If it is not possible to invoke the required functions from a hyperlink then an alternative method of access should be designed for screen reader users. This can be situated on the same worksheet in a location that is easy to access with the keyboard or it may be located on a different worksheet.

Comments

Comments are useful because they can be added to a cell which already contains data, text or a formula without affecting the contents. Properly used, such comments can provide useful additional information which will also read out by screen reader software.

How to add comments

1. Highlight the cell to add the comment to.
2. Select Insert and Comment to open a comment box [Shift F2].
3. Type in your comment as concisely as possible using appropriate punctuation.
4. Click outside the comment box to return to the worksheet [Esc, Esc].

Hints

- Screen reader software reads comments all in one go without stopping. Therefore it is important to limit the text to essential information only.
- Punctuation should also be used to ensure screen reader software handles the text properly.

Keyboard shortcuts

Shift F2 = create a new comment or edit an existing one

Accessibility checks

Before saving and sharing your information there are some basic checks you can make to help ensure that your spreadsheet is as accessible as possible.
Clear Print test

- Typeface is set to a minimum of Arial 14 point.
- A high contrast exists between font colour and the background in all of the worksheets.
- No use of italics or ornate fonts.
- No text is underlined.
- No blocks of text are set all in capitals.
- No text is overlaid on background patterns or images.
- No text is overlaid on strong colour backfills.
- Grid lines are clearly visible.
- Space between adjacent rows and columns is sufficient to avoid cluttering.

High contrast and magnification test

This test requires you to switch your display to High Contrast mode.

1. Press Alt Shift Print Screen.
2. To confirm the new setting select Ok or press Enter.

Note that the new setting may take a few moments to take effect. If the cells don't turn black minimise Excel and then maximise it again.

- All text should be visible.
- No coloured text should become harder to read against the black background.
- Any cell patterning, shading or back filled areas should not become distracting or obscure cell contents in the overall layout.

After checking press Alt Shift Print Screen again to turn High Contrast mode off.

Screen reader test

This test can be made without having any screen reader software installed on your machine. You should do the tests with each table in your spreadsheet.

Open your spreadsheet. The cursor focus should start at a logical point, such as cell A1 or else a signposted cell.
• The arrow keys can move the cursor into all cells that contain data.
• The cursor always moves one cell at a time per key press.
• With the cursor in the table area pressing Ctrl Right Arrow just once moves the cursor to the right hand edge of the table area.
• Pressing Ctrl Left Arrow just once moves your cursor to the left edge of the table area.
• Pressing Ctrl Down Arrow just once moves your cursor to the bottom edge of the table area.
• Pressing Ctrl Up Arrow just once moves your cursor to the top edge of the table area.

Checking images
• No images (such as charts) should be floating over and obscuring any text.
• A concise and meaningful text description of any image used is contained in the Alt text field under the Web tab.

Saving and sharing
When your spreadsheet is complete or after it has been edited there are a few final touches you can do to ensure that it will be as accessible as possible to other users.

You can use the following as a quick checklist:

Zoom
Zoom should be set to 100% when you save your spreadsheet to ensure no enlargement or reduction is active.

Worksheets
• Delete any empty worksheets before saving your spreadsheet. Screen reader users will not necessarily know that a worksheet is empty!
• Giving your worksheets meaningful names also helps to inform users that they contain data.

Cursor
Leave the cursor focus in a meaningful place. Excel remembers the last cursor location when a spreadsheet is saved. This will often be the top
left hand cell, A1 [Ctrl Home], but could also be a signpost cell. Screen reader users rely on the location and movement of the cursor for navigation.

**Track changes**
- Switch off Track changes before finalising your spreadsheet to avoid accessibility problems.
- If you specifically need to use this feature then it is important that you inform recipients that it is enabled.

**Toolbars**
- It is best to deactivate any floating toolbars as screen reader software may not be able to access populated cells behind them.
- If you do need to leave a floating toolbar active then attach it to the other Excel toolbars at the top of the window.

**Filters**
- Filters are not generally accessible as they can effectively obscure data.
- If you do need to use filters it is important to provide signposts or comments to indicate which cells contain the drop down menus. If filters are active and hiding information this should be noted together with details of how to turn the filters off.

**Freeze panes**
- Whilst Freeze panes are useful for keeping column and row header titles in place in a large table, they can make it difficult for screen reader users to find the top left edge. If you leave Freeze panes active best practice is to inform users and also give an instruction on how to turn them off.
- To turn off Freeze panes select Window, Unfreeze panes [Alt W, F].

**Filenames**
- Save the spreadsheet with a meaningful filename.
  - Monthly_Travel_Claim_July_2010.xls is sensible whereas montravclamjul10.xls is not!
- Note that JAWS can read joined up words properly if the first letter of each word is a capital
3. More about worksheets

Use separate worksheets

Spreadsheets can be made much more accessible if individual data areas or tables are contained in separate worksheets.

The first worksheet can be reserved for information and navigation and even hyperlinked to appropriate parts of the spreadsheet.

This significantly aids navigation especially where each worksheet is given a meaningful name rather than the default Sheet1, Sheet2 naming convention used by Excel. Any unused worksheets should be deleted to avoid possible confusion.

How to manage worksheets

1. Worksheets can be added by selecting Worksheet from the Insert menu [Shift F11].
2. A worksheet can be renamed by selecting the Format menu and Sheet, Rename [Alt O, H, R]. The default worksheet name can now be deleted and a meaningful replacement made.
3. To remove an unused worksheet select the Edit menu and Delete sheet [Alt E, L].

Hints

- Screen reader users will hear the worksheet name announced when they move between worksheets.
- By default Excel creates 3 worksheets within a new spreadsheet. Removing any unused worksheets aids navigation and avoids any possible confusion.

Keyboard shortcuts

Shift F11 = add worksheet
Alt E, L = delete sheet
Ctrl Page Down = move to next worksheet
Ctrl Page Up = move to previous worksheet
**Row and column headers**

Your spreadsheet can be made much more accessible for screen readers such as JAWS by adding row and column headers.

Effective use of row and column title headings can help to ensure that screen reader users keep a track of where they are in a particular table. Using names to define row and column titles ensures that screen reader software is able to announce the headings as cells within the table are navigated.

For this to work effectively, title headings should only be applied across one set of columns and down one set of rows in any single worksheet.

**How to apply row and column headers**

- **For a table with both row and column headings:**
  1. Place the cursor in the connecting cell (normally top left) of the table.
  2. From the Insert menu select Name and Define [Alt I, N, D].
  3. Type Title1 in the edit box and press Enter to effect the change. Note that the next worksheet grid will be Title2 and so on. There should be no spaces in the name.

- **For a table with just column headings:**
  1. Place the cursor in the cell containing the first row heading.
  2. From the Insert menu select Name and Define [Alt I, N, D].
  3. Type ColumnTitle1 in the edit box and press Enter to effect the change. Note that the next worksheet grid will be ColumnTitle2 and so on.

- **For a table with just row headings:**
  1. Place the cursor in the cell containing the first row heading.
  2. From the Insert menu select Name and Define [Alt I, N, D].
  3. Type RowTitle1 in the edit box and press Enter to effect the change. Note that the next worksheet grid will be RowTitle2 and so on.

**Hints**

- Screen reader users will hear the row and column header titles announced as they move around the table.
- Screen reader software will only recognise a single row or column as containing headers. It is currently not possible to assign row or
column title status to more than one row of column headers or more than one column of row headers in a grid at a time.

**Keyboard shortcuts**
Home = beginning of row
Ctrl Home = beginning of worksheet
Ctrl End = last cell in worksheet

**Headers and footers**
In order for headers and footers to be accessible to screen reader software the user has to know that they are there and makes a conscious choice to have them read out. You can't assume that all users will automatically check these areas.

Consequently, if important information such as contact details is stored in either the header or the footer there is a real danger it may be missed by some users.

Where headers and footers are used any important information should be duplicated in the worksheet area.

**How to make headers and footers more accessible:**
- Ensure that any important information is also included in the worksheet area as well.
- Inform screen reader users that the headers and footers contain important text.

**Keyboard shortcuts**
ALT V, H = header and footer

4. Charts and graphics

**Charts and graphics basics**
Charts and graphics should not necessarily present a barrier to accessibility. Indeed, blind and partially sighted users are likely to be equally interested in the information conveyed by essential charts and graphics.
**Charts**

To aid accessibility charts should be placed on their own separate worksheet and clearly labelled to say that they contain an Excel chart. Some of the latest screen readers are able to access charts providing that they are not too complex. For example, a simple chart showing peaks and troughs over a period of time should be perfectly accessible.

However, charts created using graphics' tools or imported from other applications will not be necessarily be accessible and may require a full text description.

Place your chart on a separate worksheet clearly labelled as an Excel chart.

- Screen reader users will need to know that they are accessing data represented by a chart. This can be done by cross referencing the data to the appropriate chart. You could use text signposts, comments or hyperlinks to do this for example.
- More advanced Excel users might also consider creating a background function to generate a text only summary from the data used to create the chart.

**Graphics**

Make sure that any graphical elements you include in your spreadsheet are actually essential and not just there to improve the design visually. Graphical elements include pictures, flow diagrams, drawings and maps which may not be directly accessible by screen reader software.

Where graphics are essential to your spreadsheet use the techniques on these pages to maximise accessibility for blind and partially sighted users.

**Hint**

It is good practice to include text descriptions and Alt text with all your charts and graphics in case they are not fully accessible by all versions of the various screen reader programs.

**Pitfalls to avoid**

There are simple techniques you can employ to improve the accessibility of your images such as dedicated worksheets and providing text descriptions. However, there are also a few things to be wary of:
- Graphics which are included purely for visual effect.
- Text which is actually part of an image.
- Text created by graphics tools such as WordArt.
- Floating graphics. These are not accessible to screen readers and at worst can obscure information in cells beneath them.
- Using graphical elements alone to separate areas in a table.
- Graphics containing thin or indistinct lines.
- Poor colour contrast within the images and between foreground and background.

**Accessible charts and images**

Using charts and graphical elements in a spreadsheet can cause problems particularly for screen reader software. However, it is wrong to assume that blind and partially sighted users aren’t interested in the information conveyed by appropriate graphics.

By considering both the location of any graphics used and the accompanying text descriptions much can be done to improve accessibility.

Detailed descriptions can be provided in the worksheet containing the graphic whilst the graphic itself can contain a concise description in the Alt text field.

**How to handle graphics**

- Essential graphical page elements should ideally be placed in their own separate worksheet away from the main data area. This will ensure that the data area remains easy to navigate from the keyboard.
- Screen reader users can be pointed to the graphic either by using a text signpost in a cell or by using a hyperlink.
- Any important information conveyed by the graphic should be text described.
- Ensure that the text description concisely describes the most important information conveyed by the graphic.
- The text description should ideally be located at the top left edge of the worksheet containing the graphic.
• Graphics should be given a concise description in the Alt text field.

Hints
• Placing graphics in separate worksheets is good practice as it allows you to add quite detailed descriptions at the top left edge without cluttering or disrupting the main data areas.
• Signpost cells can contain text in attached Comments which can be read by screen reader software.
• Try to focus on the essential information in the text description. What the graphic or chart looks like is much less important than the information it is intended to provide!

Adding Alt text
Alternative or Alt text is a way of adding information to images which can be picked up and read by screen reader software.

The Alt text should be regarded as a concise description of the image as detailed information is better placed on the worksheet itself. For example, 'Chart shows most RNIB website hits are on Monday mornings.' A more detailed breakdown of the actual number of hits per day could then be given in the worksheet.

How to add Alt text
1. Right click the image and select Format Picture from the menu [Ctrl, 1].
2. Select the Web tab and type your alternative text into the Alt text box and click OK to close the dialogue box [W, Alt A, enter text, Tab, Enter].

Hints
• Try to keep the Alt text concise as it all gets read out by screen reader software.
• Longer, more detailed descriptions if required can be placed on the same worksheet as the graphic.
• There is no need to add Alt text to graphics which are purely decorative and convey no additional meaning to the spreadsheet.
Alternative formats
In some circumstances it may be necessary to have your charts or graphics converted to an alternate format for blind and partially sighted users.

Some examples include:
- Image descriptions. Whilst text based image descriptions can be included in your spreadsheet more extensive or detailed descriptions may be required for associated video sequences, for example.
- Large print images which may need further enhancement to adjust line thickness or colour.
- Tactile graphics. There are various processes to produce images which can be felt rather than seen.

5. Printing

Printing your spreadsheet
If your spreadsheet is to be printed rather than shared electronically you can apply Clear Print guidelines to help ensure accessibility. This can be done by setting the defined Print Area if necessary to ensure a Clear Print layout and by making sure that the worksheets are printed at 100% of their normal (14 point Arial) size.

How to set a defined print area
1. Select the area to be printed.
2. Select Print Area, Set Print Area from the File menu [Alt F, T, S].
3. A defined Print Area can be removed from the same menu [Alt F, T, C].

How to prepare a spreadsheet for printing
1. Select File and Page Setup [Alt F, U].
2. In the Page tab check that 100% normal size is selected [Alt A].
3. If required Landscape paper orientation can be set in this window [Alt L].
4. Press Enter or click Ok to close the window. Note that the printable area will now be displayed as a dotted line in the worksheet.
5. To check how the pages will be divided up select Page Break Preview from the View menu [Alt V, P].

6. Select View, Normal to return to normal view [Alt V, N].

7. To check how individual pages will print select File, Print Preview [Alt F, V].

Hints

- Clear Print guidelines will not normally be met if the printed worksheet size is set below 100% to fit more information in.
- The use of coloured text, cell colouring and shading, cell borders and patterning may affect the contrast levels of your spreadsheet when printed out. Anything that reduces the contrast or locks in colours may cause problems for partially sighted users.
- If your spreadsheet prints much smaller than expected check that 100% normal size is selected in Page Setup.

Keyboard Shortcuts

Ctrl A = select whole worksheet
Ctrl P = print

Basic printing

Although many blind and partially sighted users will access your document electronically, you may still need to produce an accessible printed version. Before printing your spreadsheet you should check how each worksheet will look and ensure that Clear Print guidelines are maintained.

Print preview

It is always a good idea to check how your spreadsheet will print before committing it to paper! To do this:

1. Select Print Preview from the File menu [Alt F, V].
2. Click Close to exit the Print Preview screen [Alt C].

Basic printing defaults

1. From the File menu select Print [Ctrl P].
2. Depending on your type of printer check the following options:
   - A4 paper
   - Normal print setting
Single side printing
1 page per sheet

3. Select OK to print your document. By default all of the currently selected worksheet will be printed or the Print Area if you have selected one.

Hints
- These are the default print settings and should normally already be available on your printer.
- Paper orientation (Portrait or Landscape) should be set in Page Setup to ensure Page Break Preview and Print Preview display your spreadsheet as it should be printed.

Keyboard shortcuts
Alt F, V = print preview
Ctrl P = print

End of document